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Understanding the Workspace panel
Placement and alignment tools
Adding a still or video background to your page
Adding a music background to your page
Setting a “Loop Point”

Chapter 3

Build a Menu Page

Creating a look and navigation for your page
A menu page serves two purposes – to
serve as navigation for your viewer and to
set the tone for your disc.
DVD Architect Studio includes simple
tools for creating and designing a
menu page. It also includes tools for
customizing the look and feel of the page
in almost any way imaginable!
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CHAPTER 3

Get to Know the Workspace Panel
Create and customize a menu page
When you open a new DVD Architect Studio project, a blank, generic, blue
menu page will appear in Workspace panel.
This is your starting point. From here, you can go anywhere!
Building a menu system is like building a Web site. It can be simple, with
a few links to your media, or it can be a massive networks of links, submenus and features.
But building each page is the same essential process: Adding descriptive
text, adding links to media or other menu pages – and, of course, deciding
how it all looks and behaves.
Since most of the work of designing and building your menu page will
take place in the Workspace panel, it’s important to know your way
around this very powerful work area and understand its layout tools.

Get to know the Workspace panel
Most of the work you’ll do building and designing your menu pages will
likely be done in the Workspace panel, the large panel that dominates the
center of the program’s interface.
The Workspace is a very intuitive space to work in. Most of what you’ll be
doing in this panel involves simply dragging and dropping the elements
you’d like to add to your design. Even creating buttons that link to your
videos will done by simply dragging and dropping the clips from the
Explorer panel. (We discuss this process in more detail in Chapter 4,
Create and Customize a Menu Button.)

Zoom in or out with view controls
Along the top of the Workspace panel are controls for navigating and
viewing your menu pages. The Quick Select drop-down menu lets you
quickly select any menu page or link on your disc. The arrow buttons to
the right of this menu can be used to navigate up to the main menu or to
the next or previous menu page at your current menu page level.
At the magnifying glass icon on the upper right of the panel you’ll find a
drop-down menu for setting the Workspace zoom view of your menu page.
In most cases, you’ll likely leave this set to Auto Zoom, so that your menu is
automatically sized to fit inside the panel. But, in the event you need to see a
close-up of a particular area of your menu, you can set the zoom level at, say,
800%, using the scroll bars to adjust the view position so you can focus on a
particular area of your menu page.

Turn on the Panel Overlays
No two televisions will display your video or your videos exactly alike.
Because of something called overscan, all TVs cut off a bit of the edge of
a video frame. This is less of an issue with modern flat-screen TVs than it
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was with traditional CRTs, but it is still something to be aware of. There is
always the risk that up to 10% around the edge of your video frame will
not be displayed.
In most cases, this isn’t that big of a deal. Usually what’s around the edge
of your video isn’t vital information anyway. But, if you’re creating a DVD or
BluRay disc menu page, you certainly don’t want the title of your menu or
one of your buttons close enough to the edge of the frame that you risk it
being cut off. (Otherwise your “Gone With the Wind” video might end up
looking like “one With the Win” on some TVs!)
So, whenever you start a new video project, go to the View drop-down
menu at the top of the program’s interface, select Workspace Overlays,
then Title Safe Area. This will place a dotted line box over the menu in
your Workspace. The box doesn’t show up in your final menu. It’s just
a guide for you to keep your menu navigation and text within in order
to ensure that no vital information will be cut off when your menu is
displayed on a TV.
Other Workspace Overlays will include:
• Show Grid, which displays a grid over your menu page, a guide
for helping you compose your disc menu’s layout, and options for
displaying the order that the buttons will be selected when your
viewer navigates the menu with his or her remote control.
• Show Button Masks displays a preview of the highlights that will
appear over your buttons as your viewer navigates your menu.
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CHAPTER 3

Edit and Add Text
Create and customize a menu page

Edit or add text

Set your text’s style, size and formatting
When your text is selected (in Edit Text mode) or a text block is selected in the
Workspace panel, the text’s characteristics can be modified in a number of ways.

Edit a text box
Text boxes appear on menu pages with generic text (Usually “Menu 1”, “Menu 2”, etc. or
simply the word “Text”). To edit the text in a text box:
1

Select the text box
Ensure that the Selection Tool (the arrow icon in the upper left of the Workspace
panel) is activated and click on the text box to select it.

2

3

Click the “Edit Text” button

By default, the Font Size is set to Auto – which means that the size of the text changes
when the text box is resized (with the Resizing Tool). Designating a specific font size
locks the text to that size no matter how large – and to a point, how small – the text
box is resized to.
The B and I buttons apply Bold and Italic styles to the text’s font.
The S button applies a Drop-Shadow to the text. A drop-down menu on this button
allows you to set the X and Y offset distance (how far the shadow falls above, below or
to the side of the actual text) and to designate the color for the shadow.

The text box will become activated and the text inside will become editable.

Horizontal Alignment. The text in the box can be set to align left, center or right.

Customize the text

Vertical Alignment. The text can be set to align with the top, center or bottom of the
text box.

Select your text’s font, size and style
When text is either selected in Edit Text mode or a the text box is selected with
the Selection Tool, its font, size and style can be customized using the tools along
the bottom of the panel, as discussed on the facing page.

Add new text
There are three ways to create a text box on a menu page:
• Right-click on a menu page in the Workspace panel and select “Insert Text” from the
context menu.
• Go to the Insert drop-down menu at the top of the program’s interface and select
Text.
• Press Ctrl+t on your keyboard.
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Font size. Font sizes range from 8 point (very small) to 90 point (huge!).

The Edit Text button is located in the lower right corner of the Workspace panel.
(As a shortcut, you can click F2 on your keyboard.)

Type over the generic text in the text box.
4

Font. The Font drop-down menu will display all of the fonts that have been installed
on your computer. You can quickly jump to any font on this list by opening this dropdown menu and typing the first few letters of the font’s name.

Color. The color button will change the color of your text, which can be set using
RGB (red, green and blue) values or HSL (hue, saturation and luminance) values.
(You can toggle between the two color spaces by clicking the color box above the
eyedropper.) Color can also be set by setting the crosshairs on the panel’s rainbow
palette or by clicking on the eyedropper icon and sampling a color from any place
on your computer’s desktop – even from the interface of another program you
happen to have open!
In addition to color values, the panel includes
options for setting the opacity – or alpha level (A)
– of the text color. The alpha level determines how
transparent the text color is.
Several text blocks on a menu page can be selected at
once and stylized or colored at the same time.
Note that any settings you make – as far as your font,
text size, color, etc. – will be overwritten if you later
apply a Theme to your menu.
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CHAPTER 3

The Workspace Tool Set
Create and customize a menu page

The Workspace Tool Set

Automatic Alignment, Sizing and Spacing Tools

In the top left corner of the Workspace panel are three tools for manipulating the various
elements on your menu page.

Along the left side of the Workspace panel are sets of tools for aligning the individual elements
on your menu page.

The Selection Tool

Which tools are active and how they behave depends on which and how many elements are
selected in the Workspace panel. (Most of these tools will only function when more than one
element on a menu page is selected.) To select more than one element at a time, hold down the
Shift or Ctrl key as you click to select.

By default, the Selection Tool (the arrow icon) will be active. With this tool you can
click on and drag any element – text box, graphic or button – and move it to to any
position on your menu page.
Note that buttons, by the way, can not overlap each other even slightly. And, if you
position a button so that it’s live area overlaps another button’s live area, a red box will appear
between the buttons indicating the overlap.

The Sizing Tool
The Sizing Tool is used to resize any element on your menu page. When this tool
is selected, any element can be resized by dragging on its handles – the little gray
squares on the frame surrounding it.
When you drag on a corner handle, the element will resize, both horizontally and
vertically equally. When you drag on a handle mid-way along a frame
size, the element will resize either horizontally or vertically.
When the Font Size is set to Auto, the text will resize as its text box is
resized. When it is set to a specific size, the text will remain the same
size no matter how the text box is resized.
Additionally, when using the Sizing Tool to position elements on the
menu page, a thumbnail image and text block for a button will move
as two separate elements. This allows you to position the button’s text
so that it is to the side, above or even overlayed onto the thumbnail
image for the button. However, you should note that your button’s
“live” area will stretch from wherever the thumbnail is located to
wherever the text for that button is located!

The Navigation Tool
When you click on any buttons on your menu page with the Navigation Tool
activated, an array of arrows
will display around the button.
These arrows illustrate the
order the buttons will become active as your
viewer navigates this menu page with his or
her remote control.
Although, the selection order of these buttons
will go from upper left to lower right of your
menu page by default (and probably by
preference), you can drag on the horns that
appear on each side of your button with the
Navigation Tool and arrange the buttons to
activate in whatever order you’d like.
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Multiple element alignment tools
Horizontal Alignment Tools. Selected elements will all
align to either the left, right or center on the same point.
Vertical Alignment Tools. Selected elements will all align
to either the top, center or bottom on the same point.

“Make Same Size” Tools
Make Same Height. Automatically sizes all
selected elements to the same height.
Make Same Width. Automatically sizes all
selected elements to the same width.

“Even Spacing” Tools
Evenly Space Down.
Spaces three or more
selected elements evenly
between the top and
bottom selected element.
Evenly Space Across. Spaces three or
more selected elements evenly between
the left and right selected elements.

Individual element alignment tools
Horizontal Centering. Positions the
selected element in the horizontal
center of the menu page.
Vertical Centering. Positions the selected element in
the vertical center of the menu page.
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CHAPTER 3

Add a Custom Background to Your Menu Page
Create and customize a menu page

Add a menu button to your page
A button is automatically added to your page as you add media or a new
menu page link to it:
• For information on adding a video clip to your disc project and
adding a menu button linking to it, see Chapter 4, Create and
Customize a Menu Button.
• For information on adding buttons to your menu page that link to
other menu pages, see Chapter 5, Build a Disc Menu Structure.

Apply a Theme to your menu page
A Theme adds a look to your page, complete with text styles, button
frames and a background.
For information on using Themes to create a look for your menu page, see
Chapter 9, Work With Themes, Backgrounds and Button Styles.

Add a graphic or animated video clip to your page
In addition to buttons and text on your menu, you can add purely decorative graphics to
your menu page, including animated video clips.
To add a graphic or video clip to your menu page:
1

Select Insert Graphic
Go to the Insert drop-down menu at the top of the interface, or right-click on the
menu page in the Workspace panel, and select Insert Graphic from the context
menu.
This will open a screen in which you can browse to and select any still, graphic or
video clip on your computer.
Click OK.

2

Position the graphic
Once you’ve placed the graphic on your menu, you can move it to any position or,
using the Sizing Tool (see page 30), resize it.

If you’d like the graphic to go behind your buttons or layered with other graphics on your
menu, right-click on it and select Object Order. Selecting the options to Move Forward
or Move Back brings the graphic ahead or sends it back behind one item at a time on
your menu page; Selecting Move to Top or Move to Bottom sends it directly to the front
or directly behind all other items on your menu page.
If you are using a video clip as your graphic, you can set its looping Start Time in its
Graphics Properties, on the Media pane.
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Add a custom image background to your menu page
There are a number of ways to add a new background image to your menu page.
• Drag a background from the Backgrounds panel. DVD Architect Studio
includes over 60 backgrounds, from realistic to thematic to abstract. To add
one to a menu page displayed in your Workspace panel, drag it onto the
page from the Backgrounds panel, or simply double-click on the image in
the Backgrounds panel.
• Drag a still photo from the Explorer panel. You can also use any photo or
graphic on your computer as a custom background image for your photo.
To add it to the menu page displayed in your Workspace panel, drag it onto
the page from the Explorer panel, or simply double-click on the image file’s
listing in the Explorer panel.
• Browse to a photo from the Menu Page Properties panel. When a
menu page is displayed in your Workspace panel and no elements are
selected, the Properties panel will display Menu Page Properties. On the
Background Media page of this panel, click on the box to the right of the
Video listing. This will open a browse screen in which you can locate and
select a still image for your menu’s background. (For more information
on the Menu Page Properties panel, see Chapter 11, An Appendix of
Advanced DVD Architect Studio Tricks.)
Note that you can not add video loop as a menu page background by dragging
and dropping it from the Explorer panel. Dragging a video to a menu page will
only create a button on the page.
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CHAPTER 3

Add a Video and/or Music Background to Your Menu Page
Create and customize a menu page

Add a custom video background to your menu page
Adding a video background to a menu page is a little different than adding
a still image. If you drag a video clip from the Explorer panel onto the menu
page in the Workspace panel, a button will be added to the page.
A video clip, therefore, must be added as a background to your menu page
through the Menu Page Properties panel.
1

Go to the Menu Page Properties Background Media pane
When your menu page is displayed in the Workspace panel and its
background is selected (no page elements selected), Menu Page
Properties will be displayed in the Properties panel.
Click on the Background Media button in this panel.

2

Replace the current video.
When you click on the box to the right of the Video listing on the
Background Media page, a drop-down list will display several options.
Select Replace.

3

Select a video clip
Browse to and select a video clip on your computer.
Click OK.

Your video clip will become the menu’s animated background.
By default, this clip will play in its entirety as a menu page background
and then hold. (For information on setting your background to loop, see
page 45.) Additionally, if you have included a music clip as well as a video
background, the menu will continue to play for the duration of the longer of
the two media clips! For information on setting this duration manually, see
Set the menu loop length for your background media on page 42.
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Add a musical background to your menu page
As with adding a custom image as a menu background, there are a
number of ways to add background music to your menu page.
• Drag an audio �le from the Explorer panel. To add music or
any audio clip background to the menu page displayed in your
Workspace panel, drag it onto the page from the Explorer panel, or
simply double-click on the audio file in the Explorer panel.
• Browse to the photo from the Menu Page Properties panel.
When your menu page is displayed in the Workspace panel and
its background is selected (no page elements selected), Menu
Page Properties will be displayed in the Properties panel. On the
Background Media pane, click on the box to the right of the Video
listing. Selecting Replace from the drop-down menu that appears
will open a browse screen in which you can locate and select your
background image.
As with a video background, this music or audio will play, by default, in
its entirety as a menu page background and then hold. (For information
on setting your background to loop rather than hold, see page 45.)
Additionally, if you have included a video clip as well as an audio
background, the menu will continue to play for the duration of the longer
of the two media clips! For information on setting this duration manually,
see Set the menu loop length for your background media on page 42r.
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CHAPTER 3

Set a Loop Point for Your Menu Page
Create and customize a menu page
3

Set the background media loop Length
Set the length of time you would like your menu background to
play either by clicking on the numbers in the box to the right of
the Length listing and manually typing in new values or by using
the slider which appears as a drop-down when you click on this
property’s box.

Note that this length is displayed as hours:minutes:seconds.fractionsof-a-second. So, in order to change the media loop Length to 30 seconds,
you will need to type in the value “30.0” (thirty and zero thousandths of a
second).

Set the menu “loop” length for your background media
By default, DVD Architect Studio use a menu length that is the longer
of either the video or audio clip you have added as your menu page’s
background. This means, for instance, if you add a 45 second video clip
and a 3-minute song as your menu page’s backgrounds, the song will play
in its entirety, even after the video ends– displaying a blank background as
the audio continues!
It’s best, then, to manually set a Menu Length for your page’s media.
As a rule of thumb, most disc menu backgrounds are set to loop after
about 30 seconds.
(By the way, you should note that, by default, your disc will hold rather
than loop after your background has finished playing. For information on
setting your menu background to loop or to replay continuously as long
as the menu page remains onscreen, see page 45.)
To set your background to end its playback after 30 seconds:
1

Open the Menu Page Properties General pane
When your menu page is displayed in the Workspace panel and its
background is selected (no page elements selected), Menu Page
Properties will be displayed in the Properties panel.
Click on the General button.

2

Specify Menu Length
By default, the Menu Length property is set to Auto Calculate,
which automatically allows the background media to play entirely
through before looping.
Click on the box to the right of the Menu Length listing and select
the Specify option.
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Set a Loop Point for your background video
The Loop Point on your Menu Page Properties indicates two things:
• It is the point in your background video’s playback in which your
menu buttons appear over your menu page’s background video. (By
default, this is immediately, of course.)
Prior to this Loop Point, the background video will display with no
other elements over it. This is useful if you’d like to include some
introductory video before the actual menu page’s navigation appears.
(Another way to add a video clip before your navigation pages is to
Add Introduction Media, as we discuss in Chapter 5, Build a Disc
Menu Structure.)
• Once your background media playback reaches its end, the menu
page will loop back only to this Loop Point (It will not go all of the way
back to the beginning of your background video) so that your menu
buttons and other elements remain on screen continually after the
initial video’s play-through.
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CHAPTER 3

Set Your Menu Page Background to Loop
Create and customize a menu page

Set your menu background to loop
Whether you’ve added a musical background or a video background to
your menu page, the background clip will, by default, play to the point
you’ve specified and then hold.
To manually set your menu page background to replay continuously:
1

Open the Menu Page Properties End Action pane
When your menu page is displayed in the Workspace panel and its
background is selected (no page elements selected), Menu Page
Properties will be displayed in the Properties panel.
Click on the End Action button.

2

Set Command to Loop

The menu page’s Loop Point can be set in one of two ways: By setting
it manually in Menu Page Properties or by positioning the green Loop
Point indicator on the Timeline panel.

By default, the Command property is set to Hold, which means
that, after your background audio and/or video finishes playing, the
menu will hold until your viewer clicks on a button.

To set the Loop Point in the Properties panel:

To set the page background to repeat continuously, click on the box
to the right of the Command property listing and select Loop from
the drop-down menu.

1

Open the Menu Page Properties General page
When your menu page is displayed in the Workspace panel and its
background is selected (no page elements selected), Menu Page
Properties will be displayed in the Properties panel.
Click on the General button.

3

Set the Loop Point
Set the Loop Point of your video loop either by clicking on the
numbers in the box to the right of the Loop Point listing and
manually typing in new values or by using the slider which appears
as a drop-down when you click on this property’s box.

The page background will then play, according to the loop length you’ve
set (as on page 42) and then will repeat from either the beginning or from
the Loop Point you’ve set (as on page 44).

Additional Menu Page Properties
Definitions for more Menu Properties and a reference sheet for the entire
Menu Page Properties panel can be found in Chapter 11, An Appendix
of Advanced DVD Architect Studio Tricks.
.

To set the Loop Point using the green Loop Point indicator on the
Timeline panel:
1

Locate the Loop Point indicator
When a menu page is displayed in the Workspace panel, the page’s
Audio and Video (or still) will appear in the Timeline panel.
The Loop Point indicator is the fine green vertical line on this
Timeline.

2

Drag the Loop Point to a position on the Timeline
This location will correspond with the settings in the Menu Page
Properties panel, and you can use one tool to fine tune the location
of the indicator in the other.
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